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» This step-by-step tutorial demonstrates how to implement the fatigue

check according F.E.M. 1.001 and Eurocode 3 in SDC Verifier.
» FEM 1.001 Fatigue and Eurocode 3 detailed review;
» Implementation in SDC Verifier;
» Weld Finder Tool overview;
» Fatigue tables and plots;

» Report preparation and results.
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[permissible stress)
Allowable Stress Design method Ot Nimm?
250 e
i
The following formulae give for all values of k the permissible stresses for fatigue f / ,/// /
a) k<0 éy/ / b
- for tension : o =5.0,/(3-2.x) (1) ///7///
- for compression : 0:=2.0w/(1-x) (2) w, /7////41”/ ya 7
o is given in table above. ‘.’(": % // [ //
P // P
b) «x>o WzE o el 100
- for tension ot=0o/[1-x.{(1-00/0u)] (3) K’ //
- for compression o:=1,2. o (4) | — 0
K‘ =]
where oo = tensile stress for k = 0 is given by the formula (1) that is : 0 K
00 = 1,66 . Oy 40 o8 06 04 02 O0 02 04 06 08 10
Ratio between the extreme stresses
o+ = tensile stress for k = + 1 that is the ultimate strength or divided by the coefficient of safety Figure A.3.6.1. - (A 52; tension; group E6)
4/3: os =0,75. or

oy is limited in every case t0 0,75 . or .

By way of illustration, fig. A.3.6.1. shows curves giving the permissible stress as a function of
the ratio x for the following cases :
- steel A52;
- predominant tensile stress ;
- group E6 ;
- construction cases Wy, W1, W- for unwelded components and cases of construction for
joints Ko to Ks.

The permissible stresses have been limited to 240 N/mm?, i.e. to the permissible stress adopted
for checking for ultimate strength.
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Fatigue in SDC Verifier SDC Iz
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Custom Check (built-in, not editable) — Oa x
Kappa Factor
Options
Ky = Oy min ,," Oy max D |§ | Title |Fa:ig|..|e(hed{ | ~| Calculate Results over Directions
Ky - U)l' min / 'UY max Alias |Fa:ig|.1e_[}1ed( | | Calculate Results over Points
Kxy = Txy min ""TXN' e Description | ” v | Load Calculation ||_-|lﬂ‘|('ﬂl|)&~ v|
/| Show Parameter Description Selection |A| Entities |
Parameters (4) /
A||Owab|e StreSS Parameter = Kappa (Kappa Factor) ~

Description: Ratio between the extreme stresses
If1l: if(sweldibs > B, SweldMin / SweldMax, SweldMax / SweldMin)

a) k=0 Parameter = ST (Stress Fatigue) .
- for tension : 0 =5.0,/(3-2.x) (1) Description: Permissible stress for fatigue depends on the element group (E1-E8) and weld type

nll: Min{units.FromPaToCurrent(Switch(MaterialType, MaterialTypeEnum.Fe36@Fe37, 5T_Fe36@(

ElementGroup, WeldType), MaterialTypeEnum.Fe510Fe52, 5f_Fe51@(ElementGroup, WeldType)})),

R 75 F Ten=il=l

- for compression : =2 | a -K) 2)

oOw is given in table above.
wisg Parameter = S5llow fatigue (Allowsble Stress Fatigue)

Description: Appendix 3.6, formulas (1}-(4)

pll: if(Kappa > @, if(Sweldfibs > @, 1, 1.2} * (5 /3 *5f) / (1 - (1 - (5/ 3 *5Ff) / (B.75 *
tensile)) * Kappa), if(Sweldibs > @, (5 * 5f) / (3 - 2 * Kappa), (2 * 5F) / (1 - Kappa)))
DCY/YZ/IX: if(Kappa > @, (5 /3 *5f) /(1 - (1 - (5/ 3 *5f)/ (©.75 * tensile)) * Kappa), (
5 * 5f) / (3 -2 * Kappa)) / if(WeldType <= WeldTypeEnum.K4, SQRT(2), SQRT(3})

Egv: @

b) K>0
- for tension

- for compression

Parameter = Uf (Utilization Factor)

Descrtpfton Appendix 3.6, equivalent rule - (5)
=1 Qa'l'lmu Eatizues

Eqv: pow(me.x, 2) + pow(me.y, 2) + pow(me.z, 2) + pow(me.xy, 2} + pow(me.yz, 2) + pow(me.zx,
2) - sign(Sweldibs.X) * me.x * sign(SweldAbs.Y) * me.y - sign(Swelddbs.¥)} * me.y * sign(
SweldAbs.Z) * me.z - sign(SweldAbs.Z) * me.z * sign(SweldAbs.X) * me.x

erall: Max(me.x, me.y, me.z, me.xXy, me.yz, me.zx, sqri(me.eqv))

Utilization Factor Combined

(O'xmax/O'xa )2+(0ymax/0'ya )2 = 4// 4
Oxmax - Oymax/ (| Oxa| .| Oya|) +
(Trymax/ Tya )° < 1

Clear results oK

where the stress values oy, 0ya and T,y are those resulting from the application of formulae (1),
(2), (3) and (4) limited to 0,75 . og.
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Stress Fatigue is used in Fatigue Allowable Stress calculations. Stress Fatigue depends on:
- Weld Type (W0-W2, KO-K4);
<0 - Element Group / Loading Group (B1-B6);
- for tension : o =5 .( 3-2.x) (1) - Material Type ( St360/St37, St510/St52).
- for compression : 0c=2 Jow/|(1-x) (2)

Corresponding values of Stress fatigue in SDC Verifier:

Table T.A.3.6.1.
Values of o depending on the component group and construction case (N/mm?) Custom Check Table _ o x
Welded components (E
Unwelded components Construction cases ” XIPal Y Pal ZPal X Pal ZiFal ZX{Fal Fav el Overal .
Com- Construction cases (Steels St 37 to St 52, Fe 360 to Fe 510) 2 T [edion o ST N B ] |- ; ; : : : : - ~ Corresponding values of Stress
ponent Wa Wy W Bzme | sl | ae | EESS 35.60e+5 12750e-5 | | 147 80e+6 . . epe
group |Fe 360 Fe 360 Fe 360 oo o l , - = 1 fatigue in SDC Verifier for
St37 | St52 | St37 | St52 | St37 | St52 | Ko Ki K2 Ka Ks Sy [2-Fetgos Check gr— . .
Sta4 Fe 510 Sta4 Fe510| Std4 Fe 510 Load Group |1 Load Group 1 | Value 147.80e+6 147 80e+6 147 Ble+6 147 80e+6 CIaSSIfIcatlon bEIOW
E1 | 2491 | 2980 | 211,7 | 2533 | 1744 | 2086 |(361,9)|(323,1)[(2714)| 193,9 | 116,3
. e S Element 1D 1138 1138 1138 1 THH .
E2 | 2244 | 2617 | 1907 | 2224 | 157,1 | 1832 |(293.8)| 262,3 | 2203 | 157,4 | 944 — == 5 C:::me — o o e [ Edit Classification - o x
E3 | 2022 | 2298 | 1718 | 1953 | 141,5 | 1608 | 2384 | 2129 | 1788 | 127,7 | 766 Expand/Edreme Options Bement 0 1138 11 38 !
Table Type | Extreme {worst result on selection) | ) |1 ‘ Title |""""‘”l’|’e ‘
E4 | 1821 | 2018 | 1548 | 1715 | 1275 | 1412 | 1935 | 172,8 | 1451 | 103,7 | 62,2 ® Detaled (trem Iocations - slment and load for Load Groups) Az |WeldType |
© Short (only extremes) .
E5 | 1641 | 1772 | 1395 | 1506 | 114,09 | 1240 | 1571 | 140,3 | 1178 | 842 | 505 Descripton | [v]
Filter by - .
E6 | 1478 | 1556 | 1257 | 1323 | 103,5 | 1089 |[1275 | 1138 | 956 [| 683 | 410 becen [ . Flementil Classficstion
o : Weld Type Enum [xo <[ ey |
E7 | 1332 | 1366 | 1132 | 1162 | 932 | 957 | 1035 | 924 | 776 | 554 | 333 . st [x *| [
E8 | 1200 | 1200 | 1020 | 1020 | 840 | 84,0 | 84,0 | 750 | 63,0 | 450 | 270 T = = Selection Classification [#]
e | V| Full Model Wo l:‘
\scending All welds K1 (X) l:‘
Selection
. All welds K2 (¥)
4l W All welds K0 (X7 %]
+ All Entities I:‘
Eements
FiTe

= o ] o]
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Case K2 - Medium stress concentration

Weld Type — also called Notch Case, defines which elements belong

i . _ _ Reference |Description Figure Symbol
to what weld type (KO-K4 — joints affected by welding, W0-W2 Parts of different thicknass butt 7 e
elements and joints, not affected by welding). Weld Type depends welded (0.Q.) at right angles to the 1 L a——
. . 21 direction of the forces. Asymmetrical 2
on shape, structural design, whole pattern or type and quality of slope : 1 in 3 (or symmetrical slopes : -::EE+ ><
welds. 1in2)
Cruciform joint made with K-welds D
24 (S.Q.) perpendicular to the direction of ¥ 2 A
Case Wo the forces o
Reference |Description Figure Symbol
Parent metal, homogeneous surface. - .
Wo  |Partwithout joints or breaks in continuity TR bag(ai:ge ;;piﬁ‘éer:g stress concentralion
(SOI"d b;rs)l E't’l‘d W"h"l;" "°|‘°h| ﬁf;zcts -~ 3,11 |backing run. Backing strip secured by g <
unless the latier can be calculated. intermittent tack welds
Case Ko - Slight stress concentration -
Cruciform joint made with K-weld D
Reference |Description Figure Symbol 34 (0.Q.) at right angles to the direction ‘_\ ;_'
- / of the forces -
0,1 Parts butt-welded (S.Q.) at right ID | i
angles to direction of forces P 100 Case K, - Very severe stress concentration
il Reference | Description Figure Symbol
Case K, - Moderate stress concentration Parts of different thickness butt >b
4.1 welded (0.Q.) at right angles to the -
Reference | Description Figure Symbol direction of the forces. Asymmetrical
P >b position without blend slope ><
Parts joined by butt welding (0.Q.) at o ] 4 D
1.1 right angles to the direction of the P 100 Cruciform joint made with fillet weld &
forces - - or P10 4.4 (0.Q.) at right angles to the direction
>< of the forces >
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Element Group

SDC

Element Group also called Loading Group depends on: Class of Utilization, Load Spectrum.

Example of Load Cycles:

Numbe
Load Cycles r Total
Moves per hour 30
Hours per day 10 300
Days per year 300 90000
Number of Years 20| 1800000
Total Million: 1.8

Class of Utilization B7 (1.8 million < 2 x 10/6)

Table T.2.1.4.2. - Classes of utilization

Load Spectrum

Table T.2.1.4.3. - Spectrum classes

Symbol Spectrum factor ks,
P1 ke <= 0,125
P2 0126 < kyp = 0,250
P3 0,250 < ky = 0,500
P4 0,500 < kg = 1,000

r

Kep = (01/ Oman)® (N1 /1) + (02 Oma)” (N2 /1) + ... +(0 Oma)” (N /1) = 2 [ (0 Oma)® (M /1) ]

T i=

Element Group

Table T.2.1.4.4. - Component groups

RIFIER

Total duration of use
Symbol (number n of stress cycles)
BO n < 16 000
B1 16 000 < n < 32 000
B2 32000 < n < 63 000
B3 63 000 < n < 125000
B4 125 000 < n < 250 000
B5 250 000 < n < 500 000
BE6 500000 < n < 1.000 000
| B7 1 000 000 < n < 2 000 000
Bo < UOU 00U < n < 4 000 000
B9 4 000 000 < n < 8 000 000
B10 8 000 000 < n

Stress Class of utilization
Spectrum
class BO B1 B2 B3 B4 B5 B6 B7 | B8 B9 B10
P1 E1 E1 E1 E1 E2 E3 E4 =5 E6 E7 E3
[ P2 | E1 E1 E1 5 [=¢] E4 B [ B || E E8 E8
. E1 E1 E2 E3 E4 ES E6 =4 E8 E8 E8
P4 E1 E2 E2 E4 E5 E6 E7 E8 E8 E8 E8

M
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Launch SDC Verifier

3 R1.1 - Untitled

Open project F.E.M. 1.001 i e Seltings

Recogniions  Tools  Standards  Help

D - H F 1 ® ) Feoree = Parametric Model v

New Open™

Praoject Misc
Open I} x
€« “ A | | e Tutorial + Eurocoded Fatigue » Eurocoded and FEM1001 Fatigue Femap 2020 v | D 2 Search Eurocede3 and FEM1...
Organize » Mew folder = » [ o
~
ol Name Date modified Type Size
s Quick access
I@ F.E.M. 1.001 25/03/2016 09:19 SDC Verifier Project I T9KB
[ Desktop b4

< Downloads  #
Documents
[&] Pictures *
| Euroceded and F

|| Install

J'I Music

| temp
@ Mextcloud
@ OneDrive

[ This PC

) N
11:38:03 Floating License =¥ Network

File name: | F.E.M. 1.001

~ | | SDC Verifier Project (*.sdeov;*.sd ~
| | |

| Open | | Cancel ‘

Femap

https://sdcverifier.com
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Run Analysis

Press P to start Analysis in Femap

[} Results Manager | ‘g Governing Loads E] SDC API Consale
S

li Export Results T, Peak Finder <7 Run Script
il
Update Model  View Analyze ~ | Report Layout ‘le bod Optimization 4P Run Predefined Script
Result Post-Processing Automation
I @ Views (1) General
| B Model D 1| Tite [1ob |
;) Recognition e o
4 [ Jobs (1) .
b E Description | |V|
I % Tools )
Standards (0) Analysis Options
| & Post-Processing Analysis | Linear Static e | Analysis Options | Define... |
[£] Optimizations (0)
[ Reports (0) - | Select Loads to be Analyzed (5/5) |
Request Results
Displacement [] Strain 2;:?;5“
Applied Force [] Force Balance Selection
l} Reaction Force | Constraint Equation Solid Stress/Strain:
Force
Hot Spot Stress
[] Use Simple Stresses outside Locations [] Use Average Corner Data

oo -
11:40:58 Updating Bearmn Member Finder...
11:40:58 Updating Weld Finder...

11:49:58 Updating Beam Section Finder...
11:49:58 Updating Panel Finder...

11:49:38 Updating Connection Finder..,
11:49:58 Updating standards...

11:489:38 Project D:\Tutonal\Eurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Femap 20200F.E.M. 1.001.5dcv was opened hi

Nedes: 37803 Elements: 39707 D:\Tutorial\Eurocode3 Fatigue\Eurocode2 and FEM1001 Fatigue Femap 2020\F.E.M. 1.001.modfem MKS (Meter/Kg/Second) Femap

SD

VERIFIER

™M
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Execute Recognition =>Weld Finder => Check weld design - b X
nable to recognize weld parameters automatically. Welds that maich one e owing
E it I Model Unabl I Id ically. Welds th h of the followi
e . criteria are displayed:
4 B2 Recognition % Twe  Descpton o
1 Waming | All weld parts in a weld are welded Continuous parts in real model will be treated as welded
J _L_Joint Finder
Press F[n . . 2 Waming | Different weld part lengths in a weld Different area of the weld that will lead to stress variation
A BE-EI'I"I MEI'I'I her FlﬂdE'r 3 Ermor Length of any weld part of a weld is zero | Possible mesh disconnectivity. Weld area is 0

ﬁ Beam Sections Finder

Modes Elements  Length Criterion Welded Mon-Welded

[x] [+]

Press Close. 190 Weld 190[297? 12.27; 54?1 3 1 3 0
Edit 191 Weld 191 [-30.11; 12.27; 5.47] 9 1 3 0
192 Weld 192 [-30.44; 12.27, 5.47] 9 1 3 0

Press to Export selected sections to
components

Welds Finder s - u] X
| 4 Add, Edit, Combine and Remove Welds.
Welds | Weld Strength Settings | Hot Spot Stress |
Filter = . Apply Filter Find Weld by D | [ Navigate | li‘
D Tide Tensile Strength (Min) [Pa]  Yield Stress (Min) [Pa]  Is Symmetric lscurved  Nodes  Elements  Weld Parts Ii‘
1 240000000 3 | Set welded parts by elements | | Set non-welded parts by elements | Close
: . s |__ ' |
3 Weld 3[-29.6: 12.06: 11.53] 360000000 540000000 6 3
4 Weld 4[-3061; 126 11.53] 350000000 240000000 Ves No 3 15 3
5 |Weds et 1238 115 350000000 240000000 L I CIE There were found some Welds with
6 Weld 6[-3067; 1206; 11.53] 350000000 240000000 Ves No [ 15 3
T Weld7[-29.59; 12.27;547) 360000000 240000000 Ves No 2 2 2 all welded Parts; click to close this
8 Weld 8[-3062 1227 5.47] 350000000 240000000 Yes No 2 2 2
9 Weld9[-206; 1.2 1143] 360000000 240000000 Yes No 15 42 3 message
10 Weld 10 [-29.6: 12.22; 11.43] 3650000000 240000000 Ves No 7 18 3
1 Weld 11[-20.6; 1249; 11.43] 350000000 240000000 Ves No 7 18 3
12 Weld 12 [-29.6: 1267, 11.43] 3650000000 240000000 Ves No 5 2 3
13 Weld 13 [30.17; 1167 12.1] 350000000 240000000 No No 25 % 4
14 Weld 14 [-30.67; 11.2: 11.43] 360000000 540000000 Ves No 15 42 3 .
15 Weld 1513051, 1222 11431 Se0000000 240000000 Yer N7 " ; Move Welds. Order is important when one
16 Weld 16 [-30.61: 12.49: 11.43] 360000000 540000000 Ves No 7 18 3
17 Weld 17 [-30.61; 1267: 11.43] 350000000 240000000 Ves No 5 12 3 ~ element be|0ngS to 2 welds.
18 Weld 18 [-30.61; 12.38: 12.09] 360000000 540000000 Ves No 21 &0 3
19 Weld 19 [-30.67; 11.98; 12.1] 350000000 240000000 Ves No 2 2 2
20 Weld 20 [-30.61; 11.92: 12.1] 360000000 240000000 Yes No 2 4 4 — Preview selected Welds
21 Weld 21 3061 1175 12.1] 350000000 240000000 Yes No 2 1 4 ;
22 Weld 22 [-30.61;11.7: 12.1] 360000000 240000000 Yes No 2 2 2 l
23 Weld 23 [-3061; 1129 12.1] 3650000000 240000000 Ves No 7 50 3 0
24 Weld 2412951238 1200] 360000000 240000000 Ves No 21 60 2 — Plot Of selected welds in colors and with
25 Weld 25 1-29.6: 11.98: 12,11 ENANANNN.  ANOONONN Yes. No 2 3 3 v
Set Parameter | | Check on Weld Design | labels Of IDs
10 Looc [ el | https://sdcverifier.com
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_a CIICk As One Component ILEE ‘ Enter Component Title m X
E) Title [Selected Plates
Press OK. J! As One Component

| OK | Cancel
@P  Each Plate as Component
ﬁ As One Group 2
3

Each Plate as Group
TTTT |

New component will be created.
X J’t 7

11 https://sdcverifier.com
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Stresses for weld elements are automatically transformed

in the direction of the corresponding weld from Weld Y
Finder Tool using the wedge method. Stresses are
transformed only for plate type elements.
(oxxt0yy)  (Oxx—0yy) .
Onn = > AL > ¥Y~ « cos 20 + Tyy * Sin 260
(O-xx_o- ) .
Tne = — 2 Y s sin26 + Tyy * COS 260
(Oxxt0yy)  (Oxx—0yy) .
Ot = ¥re _ 244 * C0S 20 — Ty, * Sin 20

2 2

Oxx» Oyy, Txy — Original x,y and shear stress in local element x, y and shear directions
Ott) Onn, Tne — transformed x,y and shear stress in weld x,y and shear directions
0 - angle between the element and weld x directions.

12 https://sdcverifier.com
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Add FEM 1.001 standard SD Iz
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Execute Add => F.E.M. 1.001 in
Standards context menu.

» SDC Venfier 2023 R1.1 - D:\TutoriahEurocode3 Fatigue\Furocode3 and FEM1001 Fatigue Femap 2020\F.EM. 1.001.sdev

REwLliny=a Tools Standards  Help

ALL = 4k
F.E.M. 1.001 - performs static stress Recogrize Al ::l.: Bear':ﬁnber Panel el i tﬁt

check and fatigue check for steel ABS >
structures of crane and crane L © Views (1) AISC ’
. ) K 4 [ Model AP 3
equipment. Fatigue calculations are 4 % Components (5) ALl (2005 Edition, 2017)
. 1. 5elected Plates
performed according to Allowable Stress 4 2. Selocied Platos AS 3990 (1993)
Design method (ASD). 07" 3.Selected Plates ASME >
®h 4. Selected Plates
5% 5. Selected Welds RS (2R
I & Materials (1) DNV ¥

I T Properties (12) DVS 1608 and 1612

Ammo munlm'numumuuumum

I ¢ FEM Loads (5)
I £ Constraints (1) EN 13001 (2018)
I Cx Coefficients EEaeies N
< B3 Recognition
"L Joint Finder [ F.EM 1.001 (3rd, 1998) IL
,./:l Beam Member Finder =TT ¥
;f-f_ Beam Sections Finder IS0 5
‘=l Panel Finder
A Weld Finder Morsok NOO4 (rev.3, 2013)
Al Connection Finder Comparison Standard
4 {3 Jobs (1) '
v 1.Jeb1 Deflection
I X Tools Custom
Standards (M -
[ Post-Pro¢ |+ Add ¥ Load from Library
[Z] Optimizal _ -
) Reports ( _I Rename Multiple
= Remove Multiple
. Renumber
12:43:25 Selecte Clear Results -

12:45:45 SelectegPIEtes Was cregteg
12:45:34 Selected Plates was created

12:49:58 Saving backup file...

12:49:38 D:\TutorialEurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Femap 20200F.EM. 1.001_autobackup_20Jun2023_12-49PM.sdcb saved

12:49:58 D:\Tutorial\Eurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Femap 2020\F.E.M. 1.001_dailybackup_20Jun2023.sdcb saved

12:33:14 Selected Welds was created v

Nodes: 37803 Elements: 39707 D:\Tutorial\Eurocode3 Fatigueh\Eurocode3 and FEM1001 Fatigue Femap 20204F.E.M. 1.001.modfem MKS (Meter/Kg/Second) Femap

13 https://sdcverifier.com
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F.E.M. 1.001 Standard
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Selection: All Entities

Press to edit material properties.

Amount of materials with not defined
Tensile or Yield are displayed in the field

Tensile Strength: 360e6
Yield Stress: 240e6 and Press Set.

Press OK.

00 0o

Unit System. Stress Fatigue values are
constant for specified material and are
measured in Pa. Changing unit system
enables to convert Pa into Mpa, for
example.

14

F.EM. 1.001 (3rd, 1998) - X
ID I Title |FEM. 1.001 (3rd, 1998) |
Alias |standard! |
Description | |V ‘
Settings Selection
Weld Type (A-36.1) & [m]

Elernent Group (Chapter 2.1.4.4) |:| IE + All Entities

Material Type (A-3.6.1)

BT

Materials with Yield and Tensile = 0

Safety Factors for Static Stress Check ﬂ Elernents
Material Fatigue Parameters I} = O X
Materials Tensie Strenth [Pa] Yield Stress [Pa] Tensle Strength IPa]
360000000 240000000
Yield Stress [Pa]
240e6

[ s ]

https://sdcverifier.com
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Definition of weld categories SDC Iz
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» Weld/notch category determines fatigue resistance

» Division in welds / non welds for FEM 1.001:
» W category is for non welded parts
» K category is for welded parts

» Fatigue resistance is further specified by adding classes
» WO-W?2 for non-welded parts
» KO-K4 for welded parts

» Better fatigue resistance results in lower class number

15 https://sdcverifier.com
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Weld Classes depends on Weld Type

16

Non-weld group W0
nr. descripkion of the nain dypas syshal
W1 | Part without hole and without joint, —
WEh & nornal state of the surface,
without notch behaviour,
Slight notch behavior group KO
nr. description of the main types 5yngql
——
< o1 Parts, jointed by a butt weld of special
1 quality, perpendicular to the direckion P
of forez, c[}}:b P 100
d><p p 100
/
Moderate notch behavior group K1
nr. duscription of the matn typas syahal
1 Parts, Jointed by a butl weld of cedinary >
quality, perpendicular to the dirsction por
of faree, P100
P aor
> F 100
f
Medium notch behavior group K2
nr. deseription of tha main types synbal

an Prafiles, jointed by butt uelds of spacial
quality, parpondicular to the direction of
force.

Great notch behavior group K3

SD

VERIFIER

311 M_s jointed by a butt wald with a backing
strap, without soaling run znd perpend-
jeular to the direction of force.

Backing strap fixed by tack welding.

and a different connection type 351

= ~
P

nr. description of the main iypes

synbal

351 | Double bevel weld of ardinary quality, |
perpandicalar o the direction of foree, |

betwaen crossing parts.

VD

Very great notch behavior group K4

syndel

ne. description of the maln types

412 | Paris of different thickness, jointed by -
a butt weld of ordinary quality, n
perperdicular 40 the direction of Foreed -
ssyanetrizal Joint W1thout slope, -

e
e F

and a different connection type 451

Fillet valds of norsal quslity or single

bevel wald [included #1116t wald) ulth
backing, perpendicular to the direction
of force, between crossing parts.

N0
D

https://sdcverifier.com
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Welt Type - stress direction SDC Iz

VERIFIER

_ Parallel with weld Perpendicular to weld _

Weld K1 K2 KO

No weld WO 75(-1) = op(-1) / sqrt(3)

_ O,(-1) for k=-1 element group 5 St 52-3

Notch group WO W1 W2 KO K1 K2 K3 K4

Stress

. 163.8 130.3 104.2 118.8 106.1 89.1 63.6 38.2
amplitude

17 https://sdcverifier.com
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For beams SCF of connections can be included in the classification SDC Iz

VERI

Depends on Stress
concentrations:

Slight notch behavior group KO

M3 Gusset, ninted by outt welds of special
auality, perpendioiar :[n The dlrection i
of faree. 4 >HD 100
o p 100

Moderate notch behavior group K1

113 Gusset, !ointed by butf walds of crdinary
quality, nerpendicular fo the direction
of force,
- ——

Medium notch behavior group K2

13 | Butt weld of speeial guality end contirwous
art, both perpendicular to the diractien "]
;anr:t. at a crossing of flanges with “|>H° P00
ineselded corner plates, The snds of the —
wnlds are ground e prevent then fros cj}q:; P10a

i

For
P 100

Poar
P 100

XY

rotch benaviour,

Great notch behavior group K3
313 | Butt wald of ordinary quality and continuous
par? bolh perpendicular to the direction of
Er'c_., at @ crossing of flanges with welded
carner plates, The ands of the welds have
been ground to prevent them frem rotch
behaviowr,

P ar

P 100

-~ - P or
> i

Very great notch behavior group K4

413 | Butt weld of ordinery quality, perpandicelar
To the dlrectlon of farce, at a crossing of
flanges without corner plates,

>he
=P

(not included in this tutorial)

18 https://sdcverifier.com
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Weld Type Classification §DC

RIFIER

Press Ok-->Yes (Define for the Weld F.EM. 1.001 (3rd, 1998) _ % Edit Classification Iy - O %
Type).
D 1| Title [FEM. 1.001 (3rd, 1998) | ID I | Title |Weld Type |
Press |4 to Add Condition. . | s Weldype |
Description | |V| Description | |V|
. SDC Verifier
Settings I} i Element(s) Classification
Press Add all Welds Weld Type (A-361) ] Weld Type Enum o [T appy |
Element Group (Chapter 2.14.4) I: e WeldType is not set, Define? : I:‘ |:| Direction | " 5 Appu
i . ) Material Type (4-3.6.1) I: I:‘ Izl Salection Classification
SeIeCt MUItIple Condltlons Optlons Materials with Yield and Tensile = 0 i I—Iﬂu Full Model wo l:
Safety Factors for Static Stress Check T Elements 39707
Press X/Y/XY Lox [ concer |
X: K1 Y: K2 XY: KO

Classification Condition m O >
Press OK Weld Type Enum

Title ) One Condition |(® Multiple Condition
p

Selection | Al | Nome | [ x In [#]

(o] (o] (2] [£2] [2] ] [em] x Ko ] (]
+ All welds B My | [ko /| (]
DE [z KO . ok || Cancel |
2w i 2

Elements Ovyz ko -

D Addallweids ||| Addallintersections | iz | ko

ClEav ko

https://sdcverifier.com
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Weld Type classification intersecting welds

SDCM

00000

20

Press E to Add Condition.

Click All welds intersections

Value: K2

Directions: X

Press OK

Classification Condition

Weld Type Enum

Title |

Selection

M EEEe

+ All welds intersections

Elements

(@) One Condition () Multiple Condition

| Al || None XIV/XY
Walue

Direction ¥

Oy
Oz
Clxy
vz
zx

(=[] ]
[®][%][]

Addallwelds || Add allintersections [ Eqy

BDK

Cancel ‘

Edit Classification — O X
ID h | Title |Weld Type |
Alias |WeIdT}rpe |
Description | |V|
Element(s) Classification
Weld Type Enum | Ko “ | apply |
Direction | x “'|  appy |

Selection Classification lE'n
Full Model wo D

All welds K1 (X}

All welds K2 (Y) I:'

All welds KO (XY) [ ]

At intersecting welds all stresses
are perpendicular to the weld
direction.

The last condition overwrites the
previous ones and settings in
condition 2 => K1(X) are replaced
with K2(X) for intersections

]
]

| ImportWelds || Clear | |

R

H Cancel |

https://sdcverifier.com
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Check classification

Edit Classification - ] *
D |1 | Title |wE|d Type |
Alias WeldType |
Description | | v |
Element(s) Classification
Weld Type Enum K0 <[ appy |
Direction |x <[] appy |

Selection Classification E‘
Full Model W0

All welds K1 (%)
Al welds K2 [Y)
All welds KO (X¥) E
All welds intersections K2 (X)

»
Values
| Labels x
Selection ¥
Import Welds | | Clear || cancel | z
Xy
YZ
X
Equivalent

SDC

RIFIER

™M

O 1
C1:1

XLZ

O:1
C1:1

X&Z

https://sdcverifier.com
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Element Group classification SDC

R1FI

Press OK.

_a Press | == | for the Element Group. Add Element Characteristic - O x
D 1 Title |Element Group

Select Element Group: E6. Press To All. ‘ | ‘ |

Alias ‘ ElementGroup |

_e Description ‘ |V|

Elemental Selections

e e En T Eﬁ “ || ApplyToselected || Toau
F.EM. 1.001 (3rd, 1998) — % Selection Value
[ [Ec I

[#][x][&] [~] [+]

ID L | Title |F.EM. 1.001 (3rd, 1998) |
Alias ‘Standard |
Description | | A |
Settings Selection

Weld Type (A-3.6.1) Defined & . @ . . . . . .

Element Group (Chapter 2.1.4.4) j + All Entities |:| |:|
Material Type (4-3.6.1) @ |:| Izl
Materials with Yield and Tensile = 0 ICI
Safety Factors for Static Stress Check Elements

| ok || cance |

[ ][ [on] [oe] ]

=N [ 3

22 https://sdcverifier.com
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Material Type classification

SDC

RIFIER

Press | M. | for the Material Type.

Press To All.

Press OK.

Press OK to create Standard.

0000

Select Material Type: Fe360 (Fe 37).

Material Type defines which steel is used: St37
or St52. Stress Fatigue values are different for
different materials.

Weld Type (A-3.6.1)

Element Group (Chapter 2.1.4.4)
Material Type (4-3.6.1)

Materials with Yield and Tensile = 0

Safety Factors for Static Stress Check

F.EM. 1.007 (3rd, 1998) N - *
ID h Title FEM. 1.001 (3rd, 1998) |
Alias (Standard1 |
Description | | v |
Settings Selection

[ =[] 2] (] (@] [ow]

et |[B] [ 0

| 1] [ ][]

o]
Elements

23

Materials Characteristics - O *
ID 2| Title |Material Type |
Alias ‘ MatenalType |
Description |Fe360 or Fe510 [v|
Materials
e i E Fe 360 (Fe 37) v || ApplyToSelected || ToAl

Material Value |E|

Fe 260 (Fe 37)

B

https://sdcverifier.com
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Create extreme table SDC Iz

VERIFIER

»" SDC Verifier 2023 R1.1-D torial\f -atigue\Furocode3 and FEM1001 Fatigue Femap 2020N\F.EM. 1.001.sdev

Execute B Table (expand/extreme) in Fle Home Se = s Standards  Help
Fatigue Check context menu. TR = SN ! g
L E——

Recognize All Joint  Beam Member Panel ‘weld Connection Beam Section

Finders
Load: 1..Load Group1. TSeca Pt ~
54 2.Selected Plates
" 3.Selected Plates
i 4. Selected Plates
. 0 5.5elected Welds
Fatigue check supports only Load e o
I & Materials (1) Add r

Groups. If only one load group exist in L T Propertics (12)

. . . s # Edit
the project it will be selected 9k )
. I' Cx Coefficients
automatically. 4 B Recognition &
_), Joint Finder Remave
/: Beam Member Finde
ﬁ? Beam Sections Finde

Copy To Standard...

Table  Type: Parameter  over ] Pane Finder o ustom Check fate s -0
;Connedion Finder LlearPes s = #4

Directions. 4 @ Jobs (1) Bl Toble (expand/extreme)
I @ 1.Jeb1 D Extreme X Y z XY YZ X
I % Tools )
4 [ Standards (1) B Flow Table (over loads) Description Vale 0w w o
. HH : 4 [ 1.FEM. 1,001 (3rd, 19
Parameter: Utilization Factor. B LREM 1001 Grd, 19 B | Crterin ot Opbons : Eement 0 37186 £ e
P! ks @) Contour Plot Check 2. Fatigue Check ] | | Maximum
1.5tatic Stress | 4y Beam Member Diagram Load Group \%[ E 167 154 140
5 2.Fatigue Ch Table Structure | Parameter over Directons: v 112429 37547 1139
3.Fatigue Summation
. . oy e "3 . . Parameter Utilization Factor ~
Selection: All Entities. " &8 Post-Processing v 157 15t )
oo e Py e B
14:49:59 DA\TutorialEurocode3 Fat\gue\EummdeS and FEM1001 Fatigue Femap 2020\F.EM, 1,00]  SPand/Bxreme Options
Table Type | Extreme fworst resuit on selection)

15:04:58 Saving backup file...
15:04:58 DA\Tuterial\Eurocede3 Fatigue\Furocode3 and FEM 1001 Fatigue Femap 2020\F.E.M. 1.00 (®) Detailed (extreme locations - slement and load for Load G
15:04:39 DA\Tuterial\Eurocede3 Fatigue\Furocode3 and FEM 1001 Fatigue Femap 2020\F.E.M. 1.00 © Shot {orly extremes)

. 15:19:38 Saving backup file...
Press Fill Table. 15:19:58 DATutorial\Eurocode3 Fatigue\Euracode3 and FEM1001 Fatigue Femap 2020\F.E.M. 1.00

00000 00

Fitter by
15:19:39 D:\Tutorial\Eurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Femap 2020\F.EM. 1.00 [; E;' =
irection -
Nodes: 37803 Elements: 39707 D\Tutorial\Eurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Fi A :
Value
Sort by
Press OK. Drscton Nore -
Order Ascending -

+ Al Ertties A&

0K Cancel
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Create criteria plot

SDC

VERIFIER

Execute B2 Criteria Plot in Fatigue Check
context menu

Parameter: Utilization Factor

Direction: Overall
Point of interest: Total Type: AbsMax

Press Preview
E

Press OK

Point of interest =

ALL

Recognize All

L 7

Joint  Beam Member

Finders

Panel WeH Connection

Beam Section

i Z.5elected Mlates
% 3.Selected Plates
€% 4. Selected Plates
3% 5. Selected Welds
3% 6. Selected Welds

~

I & Materials (1)

i T Properties {12)

I <> FEM Loads (5)

I/ Constraints (1)

I Cx Coefficients

- E Recognition

_}_Joint Finder
/. Beam Member

i Beam Sections Copy To Standard...
‘=i Panel Finder |~ Move
4 Weld Finder Clear Results
sl Connection Fin
4 B Jobs (1) Table (expand/extreme)
. "(;E L"J ob1 Components Extreme Table (over selections)
00
4 [ Standards (1) B Flow Table (over loads)

ra
=]

Add
Edit
Rename
Copy

Remove

Criteria Plot

ID Title

«@1.rem 1001 B CreraPlot . po 1
[ Input
4[] Checks (3) . Contour Plot
[¥11.5tatic Beam Member Diagram

“ Ez..Fatigue THEE
4 [ Tables (1)
1.Utilization Factor (LG1, All Entities)
|i| 3.Fatigue Summation v

p— —r -
15:26:00 Calculate [S1] Check '2..Fatigue Check' - LG1.Load Group 1 started
15:26:10 Check "2..Fatigue Check' results for Load Group ‘LG1..Load Group 1
15:26:10 Calculate [S1] Check 2. Fatigue Check’ - LG1..Load Group 1 finished
15:34:58 Saving backup file...

15:34:58 D:\Tutorial\Eurocode3 Fatigue\Furacode3 and FEM1001 Fatigue Femap 2020\F.EM. 1.001_autobackup_20)u|
15:34:59 D:\Tutorial\Eurocode3 Fatigue\Furacode3 and FEM1001 Fatigue Femap 2020\F.E.M. 1.007_dailybackup_20)uf
15:36:43 1..Utilization Factor (LG1, All Entities) created

were stored

Nodes: 37803 Elements: 39707 D:\Tuterial\Eurocode3 Fatigue\Eurccode3 and FEM1001 Fatigue Femap 2020\F.EM.

AbsMax Total is absolute

maximum utilization factors among all point of

interest.

Description |

Options

Check |2. Fatigue Check

Load Group |'I..Lu.=.|d Group 1

Parameter Lhilization Factor

Direction Cwerall

LG Parameter Absolute

Paint Of Interest Total ~

View 1. Defaut View v| 4] -

Labels |Nune | Limits one |
Set Defaut Ttle | B o 0K | Cancel

https://sdcverifier.com
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Report. Tables and plots

Results => Check Tables

Press => Check ‘2..Fatigue Check’

:>@

Table Type: Extreme.

Load Group: 1..Load Group

Selection: All Entities.

Parameter: Utilization Factor.

Press OK.

[N TTITTEY

« [ standards (1)

Home Insert Results Post Processing

@ % = E;ﬁ

Expand / Components
Extreme Extreme

Table
Job Tables

E—

(over nodes)

E First Page
Table of Content
[Pl Preface

[¥] Results

DIV Appendix

4 [ 1.F.EM. 1001 (3rd, 1098)
3 Input
4 [V] Checks (3)
1..5tatic Stress Check
4 . Fatigue Check

Wizard - Empty
Wizard - Model Setup
Wizard - Results
Wizard - Full

4 [ Tables (1)
i) 1.Utilization Factor (LG
I 4" Plots (1)
[T] 3. Fatigue Summation
I Post-Processing

Designer - Empty
Designer - Model Setup

Designer - Results

Designer - Full

?EHEFEFEF BPEPEED

Presentation —

[£] Optimizations (0)
[ Repor—-=
merow oo [ Add :
152610 Che =) Repame Multiple
15:26:10 Calf i
15:34:58 Sav| — Remove Multiple
15:34:58 D:\] . Renumber
15:34:59 D\
15:36:43 1.1 "+ Generate Multiple

26

'H_rm——ﬂ_-

Group 'LG1.Load Group 1" were stored

LG1.Load Group 1 finished

3 and FEM1001 Fatigue Femap 2020\F.E!
3 and FEM1001 Fatigue Femap 2020\F.EI
ated

Import

2

Flow Summarized Forces Qutput
Vector

BHOWLE o

Criteria Contour Histogram Expand Beam Member Qutput Vector Output Vector
G

{=}

raph  Diagram Criteria

Plots

[=]

Contour

SDC

VERIFIER

™M

Add Check Tables

1] 1.5tatic Stress Check

[S1] 3.Fatigue Summation

4 Standard "1.F.EM. 1.001 (3rd, 1998)

BRI E R

Custom Check Table

Loads

Count LG1..Load Group 1

Options

Table Type Extreme (worst result on selection) v
Table Structure | Parameter over Directions v
Extreme Options

() Detailed (extreme locations - element and and load(for Load Groups))
® Short (only extremes)

Filter by

Parameter None [’

Value > 1

Sort by

Parameter MNone w

Order Descending P’

Parameters

Kappa Factor
Stress Fatigue

Allowable Stress Fatigue
n.uﬁlizaﬁon Factor

4 JENnEEE0a

legtions (1) (Elements)

| All Entities

%]

[]
[]

https://sdcverifier.com
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Report. Tables and plots SDC Iz

VERIFIER

Home Insart M Post Processing Impart

Results => Check Plots B % 2 8 &/ H . = @ &8 B[l B

Expand / Components Flow Summarized Forces Output Criteria Contour Histogram Expand Beam Member Output Vector Output Vector Check | Check
G

Extreme Extreme Table (over nodes) Vector raph Diagram Criteria Contour Tables| Plots
Job Tables Plots Standards

Search Show Parents

Press => C'-zk ‘2..Fatigue Check’ ‘ : #
El B First Page Add Check Plots - ml
=> | — | Table of Content
[FI) Preface 4 Standard "1.FEM. 1.001 (3rd, 1998)
= ] Results Stress Check

2 E 1.Job1
Y2 Individual Loads
Load Group: 1..Load Group ® fei] Load Sets
= %] Load Groups
= ¥3V] Load Group 1..Load Group 1'
@ Displacement (LG1, All Entitie
B[] Abs Usum (LG1, All Entities, v1

Parameters: Utilization Factor BB Abs Sequ (LG1, Al Entities, v, Loads (1) (Elements)
B, (¥ Stress (LG, All Entities) Count LG1..Load Group 1 - [IILL E . E E

% Displacement (LG1, All Entitie

igue Summation

L el ~

Check Plots - ]

*

— Al Entities E
= B¥ 1.FEM. 1001 (3rd, 1998) Parameters Biirections
B 1.Utilization Factor (LG1, / Kappa Factor X
H H HA] 1.0verall Utilization Facto Stress Fatigue ¥

Direction: Overall BRI Uhilization Factor (L1, All I z @
Summary Utilization Factor XY

¥Z

Bl di

[v] Appendix -

Point of Interest: Total. et a

LG Parameter | Absolute

Selection: All Entities. Views Paints of nterest
1.Default View End |/ Top
End J / Bottom
Total

Press OK.

00000000

Total calculation type | AbsMax

P e ) ]
Limits None l:‘

0K Cancel
27 https://sdcverifier.com
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Report. Fatigue Check

_a Insert => Appendix => Standards m
Description Insert Results  Post Processing Import
E E . . B9 User Chapter B Model Plat
- T Text 8 Group Plot
_9 Choose 1..FEM 1.001 EE;I::]I;?‘Z Preface Inf:ll:r?ailinn SI'IEE-:I!:IT RE%'GQ%T;EIPH 8% image - [—]
Introduc ' coloct freme R — _ - XL “Hitiong Full Chapter !
_e Press OK. Search pw Pa MNEL[I
| Searc Standards Description n
Eea Fiy o | [ G | Characteristic Plots
_e Expand standard 1.FEM 1.001 => T Filter | | | x | Classification Plots
Generate . [0 Be o [ s ] |

= ¥ Load Groups

= ¥4 Load Group "1.Load Group 1' Al

Hv Displacement (LG1, All Entities)

n [Z] 1.FEM 1,001 (3rd, 1998)
FA[+ Abs Usum (LG1, All Entities, v1)

A+ Abs Seqv (LG1, All Entities, v1, Total)

Y] Load Group 2.L1-L4' | U Genesste |
4] Load Group '3.L2-L4" l R =
V] Load Group 4.13-14 | B COPY R
Summary Cut Ctrl + X
P Apgendix : ::l:mre Del '
Select ltems ]
Apply to Selected k

28 | oK H Cancel https://sdcverifier.com
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Report. Results

SDCM

1..F.E.M. 1.001 (3rd, 1998)
Unit System

Current Unit System = MKS (Meter/KgfSecond). It is used in calculations for the following standards: APl RP 24,
I50 19902, Morsok HOO4, DIM 15018, FEM 1.001 and Euracode3.

1. Utilization Factor (LG1, All Entities)

Standard 1._FE-M. 1.001 (3rd, 1938} check [51] 2..Fatigue Check

Load Group LG1. .Load Group 1 Parameter Utilization Factor

selection Al Entities

Minimum

YWalue (10 ] 0.00 0.0a 0.00 (1]
Element ID 3746 B3465 45174 83614 M
Maximum

Yalus 1.67 1.70 140 4 04 2.
Element ID 112423 37547 1132 37547 ITE4T
Abzolute

Value 1.67 1.0 1.4 404 2.0
Element ID 112429 ITH4T 1139 37547 ITEAT

Utilization Factor (LG1, 9 Selections)

Check [51] 2..Fatigue Check Load Group LG1..Load Group 1
Parameter Utilization Factor Selection 3 selections

Components
Plate 4. stl plt 10 mmn 073 111 0.24 1.09 1.1
thks'
Plate "5..stl plt 8 mm Q.37 0.56 0.14 0.33 0.58
thks'
Plate "&..stl plt 25 mm
thks'
Plate "10. stl plt 4 mmn 0.40 0.4 0.04 0.23 0.43
thiks'
Plate "11..stl plt 12 1.05 1.30 1. 404 2.m
mm thhks'
Plate "12. stl plt 24
mm thks'
Beam "13_.stl L-bar 0.56 0.93 096
100x65=8 mm’
Beam "14_.stl L-bar 067 0.45 0.67
100x65x8 mm (top)'
Beam '15..stl L-bar 0,54 0.59 0.54

100x65x8 mm (side)’

29

Utilization Factor (LG1, All Entities)

standard 1..EE.s. 1.001 (3rd, 1938} Check [51] 2..Fatigue Check
Load Group LG1. . Load Group 1 Parameter utilization Factor
Selection All Entities

Extreme X b z Xy YZ X Eqv Overall
Minimum 0.00 0.00 0.00 0.00 0.00
Maximum 1.67 1.90 1.40 4.04 2m
Absolute 1.67 1.30 1.44 4.04 2o

Owverall Utilization Factor (LG1, All Entities, v1, Total)

¥
w_ ¢ 02
‘I > L
LA ]
i
Check [81] 2..Fatigue Check Point Total
Load Group LG1..Load Group 1 Parameter overall Utilization Factor
selection &ll Entities Wiew 1..Default View

https://sdcverifier.com
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Eurocode3 Stress history SDC Iz

VERIFIER

» A better fatigue damage can be made if load cycles are specified more
accurately.

» Instead of 2 million load cycles from start to end:

L4-L1 0,5 eb LS4, LS3, LS2, LS1], IL1
L4-L2 1,0 e6 LS4, LS3, LS2, IL1
L4-L3 0,5 eb LS4, LS3, IL1

NB gravity load is also included because the stress variation determines the fatigue damage

30 https://sdcverifier.com
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Add Fatigue Group (stress history

Select Fatigue Groups in

Navigation tree

Title: Detailed load cycles pattern

SDCM

e3 Fatigue\Furocode3 and FEM1001 Fatigue Femap - EM. 1.001.sdcv
Tools  Standards  Help

L T N

Recognize All Joint  Beam Member Parnel ‘weld Connection Beam Sechion

Finders

Select all groups and press | #

Select 1..L4-L1 and 3..L4-L3

Fatigue Item Cycles: 0.5e+6 and

Set.

Set 1e+6 cycles for 2..L4-L2

s Connection Finder - -
4 [@ Jobs (1) Add Fatigue Group

« [ 1.Job 1 D 5 Title [Detailed load

4 ‘& Individual Loads (5) o
- 1.Gravity.Mounting surface Description |

& 2.11Mounting surface
& 3.12Mounting surface

‘& 4.L3Mounting surface IE

Fatigue [tem Cycl
‘& 5.L4 Mounting surface gue [tem Cycles

3 [|[|3et to Selected |

4+ Load Sets (4) 1.Load Group 1

Title (3
% 1.Load Set 1 B)

Cycles

++ 2. load Set 2 2.14-11

J3dond a3 Total number of load

4 1! | oad Groups (4) 4.14-13

00 000

00 000

1411, Load Group 1 cycles is calculated

Hiz4-01 .
TP automatically

114

Tables {0)

' Plots (0) Count: 1 Total Amount of Cycles
I ,_( Tools w

2000000 || create ||

00000600

Press Create

P
09:34:47 Fatigue Group '1..Fatigue Group 1' created

09:45:36 Saving backup file...

0%45:36 Di\Tutorial\Eurocode3 Fatigue\Euracode3 and FEM1001 Fatigue Femap 20200F.EM. 1.001_autobackup_21Jun2023_09-45AM.sdch saved
09:45:37 D:\Tutorial\Eurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Femap 20200F.EM. 1,001 _dailybackup_21)un2023.sdcb saved

10:00:36 Saving backup file...

10:00:36 D:\Tutorial\Eurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Femap 20200F.E.M. 1.001_autobackup_21Jun2023_10-00AM.sdcb saved
10:00:37 D:\Tutorial\Euracode3 Fatigue\Eurocode3 and FEM 1001 Fatigue Femap 20200F.E.M. 1.001_dailybackup_21Jun2023.sdcb saved

W

Nodes: 37803 Elements: 39707 D\Tutorial\Eurocode3 Fatigue'\Eurocode3 and FEM1001 Fatigue Femap 2020\F.E.M. 1.001.modfem

MEKS (Meter/Kg/Second) Femap

-

Direct stress range Aay [N/mm?]

1 Detail category Ao

2 Constant amplitude
Satigue limit Agy

5 reear 1,0E408 105409 3 Cut-off limit Aoy,
Endurance, number of cycles N

https://sdcverifier.com
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Fatigue calculation with Eurocode 3

erifier 2023 R1.1 -

Execute Add => Eurocode 3 Fatigue

(EN 1993-1-9) in Standards context o e -
menu. L L /s =
Recognize All Joint  Beam Member  Panel

Consequence of Failure: Low & 403 Mounting surface
& 5.L4Mounting surface
4+ Load Sets (4)
+#+ 1.Load Set 1
++ 2.load Set 2

Assessment Method: Damage 3. Load Set 3

API

AlJ (2005 Edition, 2017)
AS 3990 (1993)

ASME

NF.EM. 1.001.sdov

SD

VERIFIER

™M

DIN 15018 (1984)

DNV

DVS 1608 and 1612
EN 13001 (2018)
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“*"4..Load Setd | Eurocode3 3 Eurocode3 Members (EN 1993-1-1, 2005)
tOIerant 4 1! Load Groups (4) F.E.M 1.001 (3rd, 1998) Eurccode3 Welds (EN 1993-1-8, 200!
i
m ;“t:_agG“’“p 1 FKM , Eurocode3 Fatigue (EN 1993-1-9, 2005)
E 3.14-12 1SO 3 Eurccode3 Bolts (EN 1993-1-8, 2005)
Hia.la-13 Norsok NOD4 (rev.3, 2013) Eurocade3 Fire Design (EN 1993-1-2, 2005)
4 FG Fatigue Groups (1) .
FG 1..Detailed load cycles pattern Comparison Standard Eurocode3 Plate Buckling (EN 1993-1-5, 2006)
EEH Tables (0) Deflection Eurocode3 Connections (EN 1993-1-8, 2005)
' Plots (0)
[ K Tools Custom
4 [ stand ;
» B 1LEE |+ Add N Load from Library
! Post-Pra =0 Rename Multiple
=| Optimiz; .— -
4 [ Reports| = Remove Multiple
g 1.Rey 7 Renumber
raee Clear Results
09:43:36 Saving

lements: 39707 D:\Tutorial\Eurocode3 Fatigue\Ey

1.15

Damage
tolerant

Safe life

1.0

1.15 1.35

32

Eurocode3 Fatigue (EN1993-1-9, 2005) N - X
D |2 | Title |Eurocode3 Fatigue (EN1993-1-, 2005) \
Alias [standard2 \ v
Description | [\] Meter/Kg/Second) Femap
Option Selection
T ieEDEEE
Reduced Range Defined + All Entities [~][]
Size Effect Defined | [H] [ ][]
Cansequence of Failure Low -
Assessment Method
Safety Factor (Gamma ) 1|
Materials with Yield = 0 b ] Elements
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FAT classes Eurocode3 §DC Iz

RIFIER

_ Perpendicular to weld | Parallel with weld _

Weld 80 :;i 100 @_} 80 r._%
" B |
o @ \_F,.l

9

Noweld 160 &7 100 %

Table 8.1: Plain members and mechanically fastened joints

Dietail . . L .
category Constructional detail Descnption Requirements
NOTE The fatigue strength curve associated with category 160 | Rolled sand extruded products: Details 1) 0 3 1
is the highest. Mo detail can rcach a better fatigue strength at any
number of cycles. 1) Plates and flats; Sharp cdges, surface and rolling
160 — e 1) Rollad sections; flaws to he improved by grinding
Hf 3) Scamless hollow sections, unitil remoyed and smooth
% either rectangular or circular. transition achieved.

14 Y
® ® ®

7) Repaired automatic or manual | 7) Improvement by grinding

fillet or butt welds for categories | performed by specialist to remove
1) to6). all visible signs and adequate
verification can restore the
original category.

100

For determination of FAT classes check standard!
In this tutorial only examples are given
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Eurocode3 Fat Class

Press Define for the FAT Class.

Full Model: 160

All Entities: 100 (No weld)

For welds: X: 100; Y/XY: 80

For welds intersections: X: 80

Press OK

SDC

VERI

FIER

M

Eurocode3 Fatigue (EN1993-1-9, 2005) N - x
D |2 | Title |Eurocode3 Fatigue (EN1883-1-, 2005)

Alizs |standara2 \
Description | [v]
Option Selection

FAT Clas (o] [v] (1] (3] [65] [m] [em]

Reduced Range Defined | + All Entities [~][]
Size Efec El L[]
Consequence of Failure
Assessment Method

Sefety Factor (Gamma M 1|

Materials with Yield = 0 b ] Elements
B[] — T

Edit Classification - ] x
ID " | Title |FAT Class |
Alias FAT |
Description ‘ |V|
Element(s) Classification
FAT Stress | 160 | apply |
Direction | x | apply |

Selection Classification
Full Model 160

All Entities 100 (XY, ¥Z, ZX)
All Welds 100 (X)

All Welds

50 (¥, X¥)

All welds intersections

50 ()

(][] (][] [+]

Import Welds | | Clear

[#]
[~]
[-]

IH Cancel |
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FAT classes plot

Edit Classification - ] x
ID 1| Title |FAT Class |
Alias (FaT |
Description | |V|
Element(s) Classification
FAT Stress | 160 || apply |
Direction | X 2 Apply |

Selection Classification

Full Model 160

All Entities 100 (XY, YZ, ZX)

All Welds 100 (X)

All Welds 80 (Y, X¥) E

All welds intersections 80 (X)
®

[e]

SDC

RIFIER

™M

Import Welds | |

Clear

o]

Values
Labels
Selection
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Fatigue Damage Plot SD Iz
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Execute Criteria Plot in Fatigue Check SDC Verifier 2023 R1.1 - DATutoriahEurocode3 Fatigue\Eurocode3 and FEM1001 Fatigue Femap 2020\FEM. 1.001.
context menu e Home Seftings [ESRUISM Tools  Standards  Help

L T O N S

Recognize All Joint  Beam Member Panel ‘wWeld Connection Beam Section
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4+ 2. Load Set 2
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G d.load Setd | #  Edit

4 Y Load Groups (4)
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= Rename

Direction: Overall Wi Copy
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114,143
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EH Tables (0)
. . ' Plots (0) Clear Results
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— Check Plat [y - ] X
Criteria Plot
H [#]1.Nominal Ch| & STIOUT POt 1
Press . Preview (]2 Fatigue Check D Toe |
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I Post-Processing v Description |
e T rany G L TG T GO U O SOy e i |y — p—
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FEM 1.001 utilization factor

0,9
0,8
0,7
0,6
0,5

0,4

0,3
0,2

0,1

Eurocode 3 utilization factor at 2 million cycles
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